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Getting started

This chapter explains how to install the Meridian Configuration Program, and gives a general
overview of its key features.

Getting started

Overview

The Meridian Configuration Program is a Windows application that
lets you design the configuration of your G Series or 800 Series
products to suit both your own personal preferences and the
particular configuration of other equipment in your system.

It uses an intuitive graphical interface that prompts you at every
stage for the information it needs to complete the system. When
you have designed the system to your requirements you can save
the configuration to the appropriate Meridian products in the
system via a serial link connected to the back of each product.

How it works

The Meridian Configuration Program reflects Meridian’s system
approach to designing audio products and presents a graphical
representation of your whole system. It allows you to create a

single configuration file representing the settings of each product in
your system and the way they are interconnected. This file is stored
in the controller of the system for future reference. As well as being
far more convenient than configuring each product independently,
this approach also enables the Meridian Configuration Program to
check that the settings you are proposing are appropriate for the
particular combination of products in the system.

The Meridian Configuration Program is structured as a wizard;

it leads you through a series of stages from the Welcome

page through to the Finish page, which is reached when the
configuration has been completed. A Breadcrumb Trail below the
toolbar at the top of the Meridian Configuration Program
window shows your current position in the sequence of pages and
allows you to jump back to an earlier page to check a particular
setting you made.




Getting started

Benefits of using the Meridian
Configuration Program

Configuring your system with the Meridian Configuration Program
offers several important benefits. In particular:

e You can configure the entire system in a single operation.

e |t is more convenient and more intuitive than using the front-
panel menus.

® You have access to many advanced configuration options that are
not available from the front-panel menu.

e You can conveniently edit the names of sources, DSP presets, and
radio presets using the keyboard.

® You can edit the G Series soft keys.

o If your controller is a G68 or 861 you can take advantage of
Meridian Room Correction.

® You can set up multiple systems far more conveniently than by
manually configuring each product.

e You can keep a record of the configuration of your entire system
in a single document on your PC.

If you have made manual adjustments to the configuration of
a product from the front panel, you can fetch the product’s
configuration into the Meridian Configuration Program as the
starting point for the configuration of your system, in order to
retain the settings, such as calibration settings.

Meridian Control Window

The Meridian Configuration Program is supplied with the Meridian
Control Window utility, a separate PC application that allows you
to control any Meridian product via a serial cable (or USB cable
on certain products) using a simple push button interface that
emulates a Meridian MSR+ or MSR remote control. Alternatively it
allows you to submit commands by name, and supply parameters
for commands that take a value, such as the volume setting.




The Products page

The following illustration shows the key features of the Products
page, which lets you specify how your system is interconnected:

dian Configuration Pragram - Untitled [Products™]

Fle View lnset Help
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- e = R ]

tat > Products > Mext

Breadcrumb Trail @ This page allows you ta insert ipraducts into the spstem by dragging fiom the Biesoice bar and dropping in the right-hand pane. YYou can Binsert a source
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< Installing the Meridian Configuration Program

Requil’ements On the Preferences page:

To use the Meridian Configuration Program you need: )
9 gram y o Leave Install for all users selected, unless you want to restrict

) ] use of the program to yourself on a multi-user machine.
o A computer running Windows 95, 98, 2000, NT 4, ME, or XP.

o 10Mbytes of free disk space.

The Meridian Configuration Program communicates with the
products you are setting up via a serial cable. The computer you are
using needs to have a nine-pin serial port available, or you can use
a USB/serial adaptor.

Alternatively some G Series products include a USB port, in which
case the Meridian Configuration Program can communicate with

them via a USB cable connected to the computer's USB port.

The software requires a mouse or similar pointing device — it
cannot be operated solely from the keyboard.

To install the Meridian Configuration Program
e Insert the Meridian Configuration Program Installation CD-ROM.

The Setup program should run automatically when the CD-ROM is
inserted. If not, locate setup.exe on the CD-ROM and run it.

The Setup program Welcome page will be displayed.

* Follow the wizard.




Quick tour

This section gives complete step-by-step instructions for creating a complete configuration for
a typical simple system. Even if this does not correspond to your own system we recommend
you follow the tutorial to give you a quick tour of the Meridian Configuration Program.

At each stage the Quick tour shows information in grey tinted boxes about the more advanced
features of the program, and the additional options for configuring 800 Series products.

Quick tour

Running the Configuration
Program

e Click Start, point at All Programs, Meridian, then click
Configuration Program:

Internet ) My Dacuments
Internet Explorer
| _“)MyRecentDocuments
cnd &
©) My Pictures
E Micrasoft Ward J My Music
i1 .1 My Computer
\',"f Paint i

I Accessories ¥ lork Places
@ Windows Media ) administrative Tooks »

_ M Meridian [l 52 Confiauistion Program Help
J Calculator =

I Startup (4 M Corfig gram s
Micrasoft Access Control Window
Micrasoft Excel B winFup

Microsoft FrontPage
Microsoft Outiook
Wicrosoft PowerPoink
Wicrasaft Word
e ) MsN Explorer
<% MsH Messenger 6.0

Log OFF Ep] Turn OF Computer

upport

The Welcome page will be displayed. This provides links to useful
information.

Using the Meridian Configuration
Program
The simplest way to use the Meridian Configuration Program is to

click the links in the Breadcrumb Trail and Information Bar at the
top of the window; for example:

Start » Products » Hest
This page allows you to insert Pproducts inta the system by dragging from the resource bar and diopping in the righthand
window, You can Finsert a source or Plinsert a speaker. If you wish to use passive speakers, you must first insert an
aplifisr

The Breadcrumb Trail shows a sequence of hyperlinks to pages you
have already visited; this is indicated by the blue underline. Clicking
one of the links takes you to the corresponding page to allow you
to check your settings on that page, or make changes. The last
entry on the Breadcrumb Trail is usually Next, which takes you to
the next page.

The Information Bar provides help about the current page, and
tells you what to do next. The Information Bar contains two types
of hyperlink: definitions, prefixed by a question mark icon, which
display a pop-up window with a definition of the item, and jumps,
prefixed by an arrow icon, which perform an action or jump to
another page.
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Starting a configuration

To start creating a configuration from the Welcome page:

o Click the Next link in the Breadcrumb Trail:

Siat> g
Fpage i the fist ane: Click the Next page (=) bulton inthe toolbar to advance o the nest page in order to begin
the configuiation pracess.

The Products page will then be displayed. This allows you to
define the products in your system and indicate how they are
connected together.

Getting help

For more detailed information about the Meridian Configuration
Program see the on-line help. To display the help:

¢ On the Help menu, click Configuration Program Help.




Products: Adding a controller

The controller is defined as the product that selects sources and
controls the volume for the system; it is the digital surround
controller, preamplifier, or combination product. In this example it is
a G68 Digital Surround Controller.

o Click the insert a controller link in the Information Bar.

An Insert dialogue box is displayed to allow you to specify the
type of controller.

e Select GB8ADV from the drop-down list and click the OK button
to add the product:

Insert Controller x|
Controller type: | GEAADY -

*ou can alva insert controllers by dragging or
dauble-clicking the contiollsr you wish ta

insert from the resource bar,

You will then be asked whether you want to fetch an existing
configuration from the controller. If you are starting from scratch, as
in this Quick tour, you do not need to do this. For more information
see the Advanced tips on the next page.

e Click the No button to indicate that you do not want to fetch
data from the digital surround controller:

Fetch from Praduct 2l
@ IF you have already set up the GESADY from the front panel

you may wish to fetch its settings.
Do you wish t fetch fram the GEBADY now?

1o

I~ Remember my decision (don't ask me again]

The Products page will then show a block representing the
G68ADV Digital Surround Controller:

rogeam - (niited [Froducts]

i
oseazn -

e e
i

I\ Vo st add hoed sesken
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Advanced tips

Adding products by dragging them from the Resource Bar
The most flexible way of adding products is to drag an appropriate
icon from the Resource Bar (to the left of the Products page)
onto the Products page:

n _Tups
2 e
= Men 51 (Radi)
=~ Blcoz R z
G51 :; HEop
GEBADY 43
GEGANY i
5680 e
BV AT
GIIDH
GI8EH
GI80H
800

Fetching settings from a product

If you have changed any settings on a product from the front
panel since making a previous configuration, you can retain the
settings by using the Meridian Configuration Program to fetch the
configuration from the product, rather than starting from a default
configuration as described above. This is also useful if you cannot
locate the file on the computer.

e Connect a serial cable between the product and your PC, as
described in To connect the serial cable, page 23.

o When the Fetch from Product dialogue box is displayed click
the Yes button.

Performing other actions
Right-clicking on most objects on the Products page displays a
context menu of actions appropriate to that object:

GESADY
[Radic 2 Fetch

2, Store

Propertiss
e

Rename

For example, to delete a product:
e Right-click the product, then click Delete on the context menu.

Note: If you delete the controller you will need to restart the
configuration from scratch.

Displaying or changing product properties
Many products provide a range of properties that you can change
for specific situations. To display the product properties:

e Right-click the product, then click Properties on the context
menu, or double-click the product.

The Properties dialogue box shows a list of the properties
associated with the product, and allows you to view or change
their values:

GEBADV Properties 2lx

Identiication | Setup | Connestions | Sources | Types |

This page displays the propetties assoriated with each a physical source: The legend
chosen wil apply to all Meridian products with soit keps.

Type: [GESADY

Legend: [Radio

- Additional information

More infomation is awailable only when you have not yet fetched ar Befiesh...

@ stored. Click the Refresh button to read the information fram the
product now,

MSFi+ key: [2 Radio] 7]

Cancel

For detailed information about each of the properties refer to the
Configuration chapterin the Installation Guide for the product,
or the FAQs section in the on-line help. To display this click
Configuration Program Help on the Help menu.




Changing the value of a property
e Click the value of the property.

e Choose an option from the drop-down list:

BB Moromods [aut LstteRignt 7]
t
F: ht N
If it is a numeric property you will get a spin button rather than a
drop-down list:

& Loom:

If it is an on/off property you can click the checkbox to change the
value:

| Fan On as necessary

i

If you have changed the value of a property an asterisk (*) is
shown after its name.

Reverting a property to its default value
e Right-click the property, then click Revert to Default on the
context menu:

% Cenbre depth®

Defauilt [0.0 ms]

The menu option shows the default value.

Configuring 800 Series products

Adding an 800 Series controller

If you are adding an 800 Series controller a dialogue box will allow
you to specify one of the product’s standard card configurations.
Alternatively select Minimal to add a minimum set of cards at this
stage, in which case you will be prompted to add further cards as
you make connections to the product:

Insert 861 2l
You can populate the $51 you have inserted to matehit to
ane of the configurations below. : xs

' Analogue Theatre

|E42, 1400, CD20, EF20, TPOO, %500 and two 0A03
cards will be added.

* Digital Theatre

|E42, 1400, CD20, EF20, DE12, 5100, TP and %500
cards will be added.

' Minimal

Only thase cards essential for the opsration of the
surround contreller will be added at this stage.

I~ Do nat display this dialog again

Adding cards

You will be automatically prompted to add cards as required
when you add sources or speakers to the 800 Series product.
Alternatively you can add cards explicitly if you prefer:

Either:
* Drag the appropriate card icon from the 861 Cards or 800
Cards tab in the Resource Bar (to the left of the Products

page).

Or:
e Right-click the product icon, then click Add Card... on the
context menu:

£ Fsteh...
2 Store...

Properties
< Delete
Rename, .

=z
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The following dialogue box allows you to specify the card type and,  Initially this shows a graphic of the card positions:
when appropriate, the position of the jumper identifying the card:

861 Properties 21x|
Card i —
Insert Card 20x| Setwp Cards | Connections | Lagical Connestions | Identiication | Types |

The maphic shaws the recommended posiions for the cards you
have defined. Fight-click within the aiaphic to add of remave cards,

of ko switch to a list view.

Lard type: | 0402 [36kHz unbialanced analogue output card] x|

dumper. [#1 [Fronts, Centres] |

AETIZ

Removing a card
e Right-click one of the outputs on the card, then click Remove

Card on the context menu. Cancel
Displaying the properties of a card To show a list of the cards:
e Right-click one of the outputs on the card, then click the
Properties item on the context menu. o Right-click, then click Details on the context menu:
A Properties dialogue box shows information about the type of v grephic 5
B 0 g 0 Add Card...
card, its slot positions, and the jumper setting: p—
Remove OAD3 Card
2ix|
General | Conneetons | This shows a list of the installed cards:
Type: 0403 (192kHz unbalanced analogue:
) e properties 2l
Slotls): 1213
Setup  Caids | Cormactions | Identiication | Types |
Jumper setting: | #4 [Fionts, Sides] > o (e S| e I
EREC 1 2728 Power supply
B3 oo s 2526 Compuiter card
EHE42 1 1417 Multichannel digital input card
EAHCD20 1 15 DSP card
ER1A00 1 35 Unbalanced analogue input card
ERHEF20 1 14 DSF card
B 0403 : 1213 192kHz unbalanced analogus output card
EH 003 2 1011 192kHz unbalanced analogue output cand
=vson 1 i3} Video switch card [compasite and 5-ideo)
B3 TR0 1 12 Tape card
Displaying information about the cards
e |n the Properties dialogue box click the Cards tab. e

You can also add a card, remove a card, or display a card’s
properties in the Graphic or Details view by right-clicking, then
clicking Properties on the context menu.




Products: Inserting a source

The next step is to add the sources in your system. For this Quick
tour we will assume a satellite receiver is required.

e (Click the insert a source link in the Information Bar.

Start > Products » Mest

This page allows pou to insert Ppraducts into the system by chagging fram the resource bar and dropping in the right-hand
window. Y ou can Pinsert & s@vce or Plinsert 2 speaker. |f you wish to use passive speakers, you must fist linsert an

amnplifier.

An Insert Source dialogue box is displayed to allow you to select
the type of source.

e Choose Satellite from the drop-down list, and click the OK
button to add the source:

[insert Sowee I
Cancel

Source type: | Satellte B

*ou can alva insert sources by diagging or
dauble-clicking the souics yau wish o insert

from the resource bar,

The Connection Wizard is then displayed to assist you in
connecting the source to your other equipment:

Connection Wizard 20|

Thls wizard will help you connect products ta your contraller. You

:ar’\ use the Meridian default connections (as abelled on the
back panel) o specify your own connections
Do you wish ta uss Meridian defaulls to connect ta the GEAADY?
% Yes (recommended) s
Ta remove existing connestions, apply the Meridian defaults,
and it the wizard, click Firish.
! € Mo (advanced]

Let me spacity my own connections
To continue, click Nest

I fulure: do not run the wizard when
inserting products

| Cancel

o | eave Yes selected to make the recommended connections
between the source and the controller.

The Meridian Configuration Program will use a set of connections
which match the back panel screening of the controller to make
wiring up straightforward

o Click the Finish button to make the recommended connections.

The connections will be displayed on the Products page:

Sat[9] GEBADY(R adiof 2]]
A Wi Witain
- 2
2 173 Whsin
(2 i
T 51 M
[ 52
53 M
54
izl Thlain
2
T3
o5
Al
43,
At
A5 aza.
46
A7
A8 sz2
o1
m]m
D5, wza.
D2
m]m
D6, Dza:
o7
D8
D9 aza.
D10
D11
D12 523
03
01
a1 wza.
0z

This shows the audio connection between the satellite receiver
optical output and the optical input O1 on the digital surround
controller, and the S-video and component video connections
between the satellite receiver and the digital surround controller.

You can now proceed to add the other sources in your system in a
similar way. In this example we are only inserting a single source.

See the Advanced tips on the next page for information about
modifying these connections; eg to use analogue rather than
optical for audio.

Quick tour
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Advanced tips

Showing a list of the recommended connections
o Click the Details... button in the Connection Wizard dialogue
box.

This shows the connections that will be made if you choose the
Yes (recommended) option:

Meridian Defaults x|
@ Optical output O will be connected to GEBADY 01

5 Wideo output § will be connected to GERADY 53
Component Yideo output Y will be connected to GEBADY 3

Specifying connections manually
e Choose the No (advanced) option in the Connection Wizard
dialogue box.

o Click the Next button to continue.

o Specify each connection that you want to make from the source
to the controller, using the From: and To: drop down lists, then
click the Connect button to make the connection:

Connection Wizard cd |

Please selact the output fiom the Satellit tat you would like to
connect to the GEBADY,

From: [4 [Anslogue] ~] Hew.
To AT [Analogue] =

= Fora mulicharnrel conrection Connect

Click Connect ta fom each conneetion; when yau have
completed adding connestions, lick Firish ta st the wizard

In futwre do not un the wizard when < Back

" Finigh
inserting products

Concel |

o Click the Finish button to close the Connection Wizard
dialogue box.

Renaming a source
You can give each source a name of up to five characters to
identify it on the front-panel display:

e Right-click the source, then click Rename... on the context
menu:

Satelite
15 Correction >
Conrect

Propetties
X Delete

The following dialogue box allows you to enter a new name:

Legend [5kd Cancel

The legend will appsar on the fant panel of
products ta which the souree is comnected.

@ The name you chaose may not exceed 5
characters in length, and must contain only

alphanumeric, space, hyphen [ and period
characters.

Changing the MSR+ key for a source
You can choose which MSR+ key selects each source:

e Right-click the source, then click Properties on the context
menu.

o Click the Identification tab in the Properties dialogue box.
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e Choose the MSR+ key from the MSR+ key drop-down list: e Drag between the output on the source and the input on the
controller that you want to connect:
2|
Idertiication | Cannections | GO7 ICD) |I351 (R adio]
@ This page displaps the properties associated with a physical souce. The legend chosen o1
applies to all Meridian products with soft keps.
o —— ~RAB
Alo— AT
Legend: [Sat MSRekep[35a] 7] Type: [Satelite 1 e
<nonex &9
1[CD]
3[DWD] Ald
4 [Au] Al
5 [Disc]
[ Taﬁe
Els When you release the mouse button the cable will be connected:
11 Neh
12 [Game] "
GO7 [CD) G51 [Fadio)
o1 A5
o [ e
x1
Cancel ua
AlD
Al
Showing and hiding connections
You can choose whether or not source connections are displayed If the connectors are incompatible a stop cursor will be displayed:
by clicking the View or Hide Source Connections button in the
. GO7 [CD) G51 [Fadio)
toolbar:
Dig— —
a1
Al
:}' %1
Displaying information about the style of each

connection line

) . Removing a connection
 On the View menu, click Legend.

e Drag from one of the connectors and release the mouse button:

Connecting using drag and drop GO7 [CD) 51 [Radio]
You can also connect between any two compatible connectors o _l_ A
using d d drop: S
g drag and drop: e o
}( A
Ald
Al

The cable connecting the two products will be removed.
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Making a multichannel connection Adding or removing inputs or outputs

If you are connecting a product with multichannel outputs, such With non-Meridian sources you can add new inputs or outputs,

as a G98DH DVD Player, to a digital surround controller with or remove inputs or outputs, to reflect the connectors provided by
multichannel inputs, the Meridian Configuration Program can your source. For example, if your satellite receiver includes a digital
create a multichannel configuration when you drag between two coax output you can add a connector for this:

appropriate connectors:
e Right-click one of the source’s existing connectors, point to

[GIEDHDVD(3] *‘]
A Connection on the context menu, then click New... on the
s submenu:

e

ne] (5at)
= 5
E: Dza: | o Fioperties
E: o Connect.. Remuye
oo Er. ican
oz 123 % Delste .
= Repame..

Disconnect

A prompt allows you to choose whether to make a single or The Add Connector dialogue box allows you to define the new

multichannel connection. connector.

If you choose Yes the multichannel connection will automatically « Specify the type of connector using the Class and Type drop-

be made: down list, enter a name, and choose Output or Input as
(G360 HDVO[3] :;]M - appropriate:
5 g s 2]
= o

&9 & ‘You can add & input or output
40 sz2 0 O
S [E: % D1 @ to the product to reflectits L .
IS n;]- physical characteristice.

Dz

Cancel |

= Cless: [pudio =

8 o |

o 023 Ivpe: |[Digital Coas =
03

o s Hame: D1

o1

o & Dutput  © Imput

012 323

e (Click the OK button to add the connector.




Products: Adding speakers

The next step is to add the speakers in your system.
o Click the insert a speaker link in the Information Bar.

The Insert Speaker dialogue box allows you to select which type
of speaker you want to add, and the positions in which to add it.

e Select DSP8000 from the Type drop-down list.

The Location will automatically be set to Front left/right:

T TR 1l
D I e I

| Location -
|
e |

e Click the OK button to add the speakers.

The speakers will be added to the appropriate points in the layout,
and the connections will automatically be made between the
speakers and the controller:

alalx
St » Procta » bisal
‘i) The s Fee 5 Vous can Pt 4 jcace
i GEBADV [Fadol
rn vt Tt
] n
[Ty W oseson i hise
8 5P i P
B osPeEn o
2 mpseme » e
DAPEO00 T ]
] =
i DSFEO0 o =l
Akt [sctve] - W
2 [ s e g Fries
Wi i . Eaie LAY
ué al ohai]
B Submecin . Bl
| s - lnhl
o0 ﬂn rini
| Lo
- D q_ o
x L
bow v b
pev
o L |
o
fots oo
o =
pan v

o Click the insert a speaker link again and select DSP5500HC
from the Type drop-down list to add a centre speaker:

Type; [DSPSSO0HC =l Cancel

Laocation

[(-‘ ;ennelj € Rear Ielt/rlghl|;|

The program will offer to add a 511 patch box to the layout to
connect the Comms cables for the speakers:

Insert 511 for Digital Speaker 20

A 511 slave patch box is required in order to connect the digitsl speakers
Dia you wish to insert ane now?

. [

I™ Remember my decision [don't ask me again)

o Click the Yes button to confirm.

o Click the insert a speaker link again and click Analogue
(passive) on the Type drop-down list to add small analogue
rear speakers:

Insert Speaker

Type: [#nalogue [passive)

Location

 Bear left/iight l;‘

o Click the OK button to add the speakers.

The Meridian Configuration Program will automatically prompt you
to add an amplifier to the layout to drive the passive speakers:

Insert Amp for Passive Speaker 21l

@ Do you wish to insert an amplifier to diive the passive speaker?

]t

I~ Remember my decision (don't ask me again]

Quick tour
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o Click the Yes button. Finally insert a subwoofer into the layout:

o Click G57 on the Amplifier type drop-down list, and click the

OK button to add the amplifier: o Click the insert a speaker link in the Information Bar and select

Subwoofer from the Type drop-down list:

R =]
’E_:‘J'—“'—j 2%
gl hpe | 557
7 sy correc o corten Type: | Subwoofer =l k] cancel
B ~Location
% Mono/Centre/LFE E‘ " Stereo Ielt/rlghllE‘
The G57 will automatically be connected up to the appropriate ~Widh
© wid
analogue output on the digital surround controller: (o e ool e o
?ﬁgiﬁhwmm has no erossover, of it should be bypassed
Maeicin w alml=
[ Yem e _ _
e dmd il M B You can proceed to add any other speakers in your layout in a
similar way.

o Click the Next link in the Breadcrumb Trail to proceed to the

next page.

$9 88805 QEERE




Advanced tips

Adding a speaker by dragging it from the Resource Bar
e Drag an icon from the Speakers tab of the Resource Bar (to the
left of the Products page):

Mame [DSPSS00HC

B osPaz o (Z
B

DSP420
B osesoon

8 DSP5000C

B ospssoo

=8 D5PE500HE

B ospeoon

B osF7oo

B ospaoon

H 2nalogue [active]
F Analocue [passivel

| Other | Sowsees | Amplifiass | Spadkazs

e Drop it onto the appropriate speaker position.

Adding a speaker at a specific position
e Right-click the position, point to Insert on the context menu,
then click Speaker... on the submenu:

1t » e

I
Comnections »  Source,
Arplfier,

Other Product...

Alternatively, double-click or right-click the speaker position.

Reviewing and printing the source and speaker
connections

Additional Speaker connections and Controller connections
pages can be displayed to allow you to check the source and
speaker connections, or print out a copy for help in wiring up the
system.

¢ On the View menu, click Review Pages.

The Speaker connections and Controller connections pages
will appear in the Breadcrumb Trail after the Soft keys page:

(11} Meridian Configuration Program - Untitled [Speaker connections*] 3 -1ol x|
Fil= Yiew Inseit Help

Stail > Products > Spesker comedions > GEEADV connections > Bass mensgemert > Nest
@ This page shows Speaker connections. YYou can Eipiint the page to prowide a quide o wiring yor systern. You can ako view|

speaker connections in graphical form by returning ta the ® Procuucts Page and clicking the Speaker or Comms Connections
buttorrs o the toolbar,
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Displaying or changing the speaker properties

To display the speaker properties right-click the speaker symbol,
then click Properties on the context menu, or double-click the
speaker symbol:

General | Connections |

Model  Generic

Type: Analogue subwoafer
Active:  Yes

Location:  Front centre
Channel: 4

Role: LFE/Centre/LFE

Froperty [ Value [
% Gair 008

= Size” 28

EH Phase Pasitive

I widih Nanow

% Distance® | 140"

Cancel

You can edit the properties in the same way as for source
properties.
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Soft keys

The Soft keys page allows you to customise the soft keys for each
of the G Series products in the system, starting with the controller.
In this example the only applicable product is the GB8ADV.

An initial recommended layout is provided for each product; for
example, for a G68 this provides soft keys for each of the sources
in the system, plus a DSP key in the rightmost position.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.

voquam - Linticled [GEIADY ol k"]




Advanced tips

Changing the soft key layout
e Drag a soft key, or pair of keys, from the left-hand pane onto the
set of soft keys you want to edit:

Buttonl Button2 Button3 Buttond ButtonS

e 1 1 1 | |
=== [ I I I B

e Hold down to insert the key(s), moving existing keys right to
make space.

You can undo or redo changes to the soft key layout by clicking the
Undo or Redo buttons in the toolbar:

D@ HE[E | e=2 g,|||3[gm|k?@|

The first 12 soft keys correspond to the 12 MSR+ keys. Only the
ones corresponding to the sources you have defined in your system
will be available — the others will be greyed out. Their names will
reflect the names you have given to the sources on the Products

page.

Soft keys that work in pairs, such as balance, bass, treble, and
bright, automatically occupy two adjacent soft key positions.

Renaming a source
e Right-click a soft key corresponding to a source, then click
Rename Source... on the context menu:

All occurrences of the source in the soft key sets will be changed.

Clearing a soft key
e Right-click the soft key, then click Remove on the context menu:

DSP

Restoring the recommended layout

e Click the Reset button for a recommended assignment of soft
keys.
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Bass management

The Bass management page specifies how bass is handled in
the system for each of the three speaker layouts. The settings are
automatically set to recommended values and can be ignored for a
simple configuration.

Advanced tips

Meridian digital surround controllers allow you to define three
different speaker layouts for use with different types of material:
Music, Logic, and 5.1 Movie. The Bass management page

allows you to specify how the bass is handled in each speaker
layout:

* Meridan Configarahon 'rogias - Lintited [Bar management”]

= 0l =
Irasn sk

e = A
wy Thapege

)
e | Loge | 5 Mo |

[ e (T e e Nl |

Man spasiann dmaban

Fgrts Lo = e

The sont speskss ol s waedt e

R hlrance rezwodnen,

Lome [fna 7] Bt pubecler

: st || [ty 3]
[
::umaﬂrgxm o Bl _.‘:“ =

Beoundary gom cospemiatn Lo i en,
TH Dty

Specifying which speakers should handle the bass

The Main speakers and Surround speakers sections allow you
to specify whether each speaker is Large, in which case it will
handle the bass for that channel, or Small, in which case the bass
for that channel will be redirected to another speaker.

o Click the Next link in the Breadcrumb Trail to proceed to the
next page.

You can choose whether the main front and centre speakers are
specified as Large or Small for each of the Music, Logic, and
5.1 Movie speaker layouts.

The diagram to the right of each tab represents the selected
speaker layout; select Display bass flow to display red arrows on
the diagram indicating how the bass for each channel is handled by
the speakers in the layout for either Multichannel or 2-channel
sources as specified (see below).

Specifying which subwoofers are used in the layout

In the Subwoofers section you can specify how many of the
subwoofers are used in the layout. Subwoofers used in the
layout are indicated by a black square in the layout diagram, and
subwoofers not in use are indicated by a white square.

If there are no subwoofers in the layout the front speakers must

be specified as Large, and they will handle the bass for any other
small speakers in the layout.




If there is one subwoofer in the layout, and you have specified the
front speakers as Small, the subwoofer will be used for the bass
and LFE. If the front speakers are Large and the centre speaker is
Small, the Front subwoofer option allows you to choose from
the following options:

* Not available for the Logic layout.

If the layout includes two or more subwoofers, the subwoofers will
handle the bass and LFE for the system irrespective of the size of
the front speakers.

Specifying the crossover settings
For each speaker layout the Crossover option allows you to set
the crossover frequency for the subwoofers. This is ignored if the
subwoofers are only handling the LFE.

The Meridian digital surround controllers provide very high-quality
crossovers for the subwoofers, and for best results you should

use these instead of the subwoofer’s crossover. To do this set the
subwoofer Width property to Narrow, and remove any crossover
in the subwoofer, or set it to the highest setting (eg 200Hz). If
you cannot do this, set the subwoofer Width property to Wide to
switch off the digital surround controller’s crossover and use Sine/
Sub mode to match the subwoofer’s crossover frequency.

The LFE low pass filter option sets the low-pass filter for the LFE
channel, for the Music and 5.1 Movie speaker layouts.

o Click the Reset button to reset the crossover and low-pass filter
to recommended values in all layouts.

Specifying the THX settings

The THX settings tab allows you to specify that your subwoofers
are THX Ultra2 approved, and select Boundary gain
compensation to reduce bass levels if listeners are close to a
wall. Click the THX Defaults button to set the crossover and low-
pass filter to 80Hz in all layouts, as recommended by THX.
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Speaker distances

The Speaker distances page gathers information about the
relative positions of the full-range speakers in your system, and the
distance of each speaker from the listening position. First choose
the units you would like to work in.

© On the View menu, click Metric or Imperial.
® Measure the distance to each speaker in the specified units.

o Drag the speakers until they are in the correct positions, with the
correct distance shown on each speaker icon.

This information is used to calculate the speaker delays, and
generate the aspect ratio and rear speaker separation.

Advanced tips

e Click the A or ¥ buttons to the left of the scale indicator to
change the scale of the whole diagram.

o Click a speaker to select it, and then use the arrow keys to move
the speaker in the corresponding direction.

o Use and to move a speaker away from or
towards the listening position. Hold down to move all the
speakers at once.

o Use and to move a speaker in a circle around the
listening position.

e Click the Scale to Fit button to increase the scale so the
loudspeakers fit neatly in the window.
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o Click the Next link in the Breadcrumb Trail to proceed to the
next page.




Speaker calibration

The Speaker calibration page allows you to calibrate the
speakers attached to your controller while listening to the product.
You can use the Meridian Configuration Program to step between
speakers, and change the properties of the currently selected
speaker, using the on-screen buttons.

To connect the serial cable

e Connect one end to the RS232 connector on the back panel of
the controller in your system.

e Connect the other end to one of the serial ports on your
computer.

The default is COM1. If you have to use a different port see
Advanced tips overleaf.

The Speaker calibration page shows a list of the speakers
connected to your controller and the current distance, level, and
phase settings of each speaker:
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o Click the Start button.

The Meridian Configuration Program stores the settings you
have created to the controller and then automatically starts the

calibration sequence so you can tune your speakers by ear using a
series of listening tests:
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e Use the €, >, A, and ¥ buttons on the Speaker calibration
page to control the product; refer to the appropriate guide for
your product for details of the calibration procedure.

The product’s display is shown above the arrow keys on the
Speaker calibration page.

e When you have completed the calibration procedure click the
Exit button on the Speaker calibration page, or the Off
button on the product, to fetch the calibration settings from the
controller.

The calibration settings will be shown in the speaker list on the
Speaker calibration page.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Room correction

The Room correction page runs the Meridian Room Correction
procedure. This is optional and you can skip this stage by clicking
the Next link in the Breadcrumb Trail:
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For information about running the Room Correction procedure see
the chapter Room Correction, page 31.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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DSP presets

The DSP presets page shows a list of the DSP presets available to
the digital surround controller, and allows you to edit the properties
of each preset. You can also edit the preset mappings, to change
the default DSP preset selected for each source and each audio
format.

Advanced tips

The Preset Properties pane shows the name and value of each
of the preset properties:

~Preset Propeti
[T All presets Property [ Walue
£ Dirsct # Balance 0
£ Music $ Centielevel oo
< Trlield % Centre depth 10ms
£ Ambisonics || &
" Giper 2 Rear delay 0.0 ms
: Staren % Flear lovel 0
 MusicLogic EAE Rear LPF o
 Moro % Lipsyne 0.0 ms
¢ TV Logic [ HS out Yes
i PLIl Music Fioom conection profile | Bypassed
© PLIMovic | | % LFE level 0ds
£ PLINTHK Compression Compress off
¢ Discrete B Surmound option Rears
B Cincma
[ THY
8 Music 2
4 [

Some properties apply globally to all presets; to edit these select
All presets in the Preset Properties list.

Displaying and changing the properties for a preset
o Select the preset in the left-hand list.

You can then edit the properties in exactly the same way as for
product properties; see Changing the value of a property, page 9,
or Reverting a property to its default value, page 9.

For full information about the parameters for each DSP preset see
the Installation Guide for your product.

For a simple configuration you can skip this page.

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.

Creating user-defined presets
You can create additional user-defined presets with specific
properties:

o Right-click the preset you want to use as the basis for the new
preset, point to Copy to on the context menu, then click New
Preset on the submenu:

Pevert to Defauits |
Mew Preset

Revert All to Defaults. Preset "Music 2

If you have already created one or more user-defined presets, you
also have the option of overwriting an existing user-defined preset.

Restoring presets to their default values
o Right-click the preset, then click Revert to Defaults on the
context menu:

TN

LCopy to

Revert All to Defaults

o Alternatively click Revert All to Defaults... to revert all the
built-in and user-defined presets to their default properties.
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Tuner presets

For each product in your system that includes a radio tuner, a
Tuner presets page allows you to define the legend displayed on
the front panel display for each tuner preset, and the waveband,

frequency, and audio mode it selects:

@>m D2 comey » GESALY v gicogty

e Click the checkbox in the Number column to enable the
corresponding tuner preset, and edit the Legend, Frequency,
and Audio Mode as required.

e Set Display Legend to No if you want the display to show
the RDS station name, or frequency if no RDS station name is
available, rather than a predefined legend.

When you have edited the tuner presets as required:

e Click the Next link in the Breadcrumb Trail to proceed to the
next page.




Store settings

This page stores the settings to the controller:
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e Connect the serial cable.

For more information see 7o connect the serial cable, page 23.
e Click the Start button to store the settings.

When the store has completed:

o (Click the Next link in the Breadcrumb Trail.
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Finish

The Finish page confirms that you have successfully completed the
configuration of your system.

Save a copy of your configuration

Although a copy of the configuration document is saved in the
controller for your system, it is recommended that you also save

a copy of the final configuration document on your PC, with an
appropriate name, so that you can refer to it again at a later date,
if necessary.

® On the File menu, click Save, or click the Save button in the
toolbar:




Room Correction

The G68 and 861 digital surround controllers incorporate room correction, which takes
advantage of advanced digital signal processing techniques to compensate for room artefacts,
including resonances and reflections, to give a significant improvement in the sound.

This chapter explains how to use Meridian Room Correction to create profiles for use with the
digital surround controller.

Room
correction

Introduction

The Meridian Room Correction procedure creates a set of one or
more room correction profiles matched to your room. These are then
downloaded to the digital surround controller and can be associated
with particular presets, or selected from the front panel. Selecting a
profile applies a set of digital filters individually to each speaker to
achieve the required room correction.

If you use a single speaker layout you may choose to have one
room correction profile, and use this with all presets. If you have
separate speaker layouts for use with Music, Logic, and 5.1 Movie
sources you will need to calculate a separate room correction profile
for each speaker layout. These will then be selected automatically
by the digital surround controller depending on the audio format. In
addition, you can create separate room correction profiles to take
account of changes to the room, such as the position of large items
of furniture, or with curtains open or closed.

How room correction profiles are
calculated

Calculating a room correction profile is a time-consuming and
mathematically complicated process. Meridian Room Correction
performs the necessary sequence of measurements and calculations
automatically, using a PC connected to the digital surround
controller, with the minimum of interaction. It works as follows:

First you need to set up a microphone close to the listening
position, and connect this to an appropriate input on the digital
surround controller. On the G68 Digital Surround Controller this will
be A8 (L). On the 861 Reference Digital Surround Controller this can
be any analogue input; input A1 on card IAQ0 is chosen by default.

Usually a standard sound pressure level meter will be used as a
microphone; this can be the same one used for setting the speaker
levels during the Calibration procedure. After an initial short test
sequence, designed to check that the microphone is set up correctly,
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a test signal is presented to each loudspeaker and measured at the
microphone to determine how the room response affects the sound
from each speaker. This stage of the procedure takes about one
minute per speaker, and can be left to run unattended.

Finally, after a complete set of measurements has been made

for each channel and speaker layout, the program calculates a

set of filters for each channel, and stores these to the digital
surround controller. A copy of the measurements, together with the
calculated filters in each profile, is also stored on the PC so they
can be accessed at a later date if required.

Examples

Most domestic rooms tend to be rectangular, or at the very least
have one pair of parallel facing walls, and unfortunately these are
the ideal conditions for low frequency resonances within the room.
The wavelength of low frequency sounds is relatively large, so even
bookcases and curtains act as an almost perfect mirror for low
frequencies.

Frequencies close to the resonant frequency, determined by the
distance between the two reflective surfaces, will sound louder and
take longer to decay than other frequencies. In practice this means
that when listening to music some notes will sound louder, giving a
roughness or unevenness to the sound.

Other problems that can be corrected by room correction are
imbalances between the speakers due to positioning constraints.
For example, in an L-shaped room one loudspeaker may need to be
close to the wall whereas its partner is in an open area, giving rise
to an imbalanced sound field.

Unless your listening room has been specially designed for acoustic
performance, you will almost certainly hear distinct benefits after
incorporating room correction into your digital surround controller,
and if the room has major resonances or imbalances the difference
should be quite dramatic.

You can find more information about the theory behind Meridian
Room Correction on the Meridian Web Site at:
http://www.meridian-audio.com/p_rc.htm




Auto Build

This section explains how to create a basic room correction using
default settings.

The room should be as you would normally use it for listening.
Close/open doors, close/open curtains, and position your screen
and furniture as they would normally be for listening.

If you are creating room correction profiles as part of the initial
configuration of your system, follow the procedure described in
this chapter when you get to the Room correction page in the
sequence of Meridian Configuration Program pages.

If you decided not to create room correction profiles when you
first configured the system, start from the saved configuration
file, or fetch the configuration from the digital surround controller,
and then step forward to the Room correction page in the
Breadcrumb Trail:
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To set up the room correction options
The first step is to specify options for the room correction
procedure.

o Click the Options... button to display the room correction
options:

Options R E |

General | Serial Port | Colours  Rioom Canection |

Microph
) Please ensure that the microphons is
’753”3"‘“ T 7] Conmeeted o 558 outaut 48 M)

Maximum measurement ieties: |3 _|::'

Cancel

o Specify the sensitivity for the microphone.

When first running room correction it is recommended that you
leave this at its initial setting.

If you are using an 861 Reference Digital Surround Controller you
will also need to specify the card and input you are using for the
microphone.

o Specify the maximum number of measurement retries; by default
this is set to 3, but you can enter a lower value to reduce the
time taken by retries.

o Click the OK button to confirm the options you have specified.

Room

correction
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o |f you are using a G68 Digital Surround Controller connect the
SPL meter or microphone to the analogue input A8 (L).

o |f you are using an 861 Reference Digital Surround Controller
connect the SPL meter or microphone to the analogue input you
specified in the Options dialogue box.

e Position the SPL meter or microphone at the listening position
and, if you are using an SPL meter, switch it on.

When using an SPL meter, the C weighting must be used. The 90dB
range is recommended unless the loudspeakers measured less than
75dB SPL during the calibration, in which case the 80dB range is
recommended.

To run the Auto Build procedure
o Click the Start... button.

A countdown dialogue box will give you time to leave the room:
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A test tone will then be presented to each loudspeaker in turn
for each of the distinct layouts defined in the digital surround
controller configuration file.

Depending on the number of channels and layouts in your
configuration this may involve up to 24 tests and take up to 20
minutes to complete.

The Room correction page shows information about each test
and a progress bar indicates the percentage completed:
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When the measurements have been completed the following
dialogue box allows you to apply the room correction profiles:

Apply Room Profiles 21|

Do you wish to apply the profiles pou have created to all presets?
IF you choose Yes, each preset will be assigned the last profile valid for its DSF mode.

I~ Remember my decision (don't ask me again)

o Click the Yes button to assign an appropriate profile to each
preset.




Each preset will be assigned the profile designed for the layout
used with the preset. The wizard creates profiles called Mus, Log,
and Mov for the Music, Logic, and 5.1 Movie speaker layouts
respectively. If two or more layouts share the same settings, the
profile name will include all the layouts it applies to; for example,
MusLog or MusLogMov.

What next?

You have now completed the Auto Build procedure, which creates
a recommended set of room correction profiles. In most situations
this is all you need to do in order to take advantage of room
correction with your digital surround controller.

The next sections describe some of the more advanced options
available on the Room correction page, including the options
for re-measuring channels, selecting different filter parameters, and
manually editing the filters.

Room

correction
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Viewing and repeating measurements

The Measurements tab shows a list of the measurement sets you
have created. Each measurement set shows the channels measured
for each of the speaker layouts set up in the digital surround
controller configuration:

Measurements | Frofies |

Measurement Set_ | Music | Logic [ 5.1 Mavie |
} Measurement LRLCLFELzRsLiRr  LRCLsRsLiRr LRLFE LsRsLiRr

You can also create additional measurement sets; for example to
cater for different furniture layouts. For each measurement you can
view the effect of applying different profiles.

The Measurements tab gives you the option of viewing

or comparing the measurements. You can also repeat the
measurements for individual speakers; for example, if an external
noise interfered with the test procedure.

To view the measurements
o Right-click the measurement you want to view, then click View
Plot on the context menu, or double-click the measurement:
3 Mew

Bename
¥ Delete

P Measue..
Re-measure,

=

The Plot Measurement window allows you to see the
measurement for the specified channel:
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o Select the profile from the Profile drop-down list.
To show the uncorrected response select Bypassed.

You can compare the effect of two Profile settings on the same
plot by clicking one of the split pane buttons:

8l 0
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You can then set different Profile settings for each plot: Shows the response of the room to a series of short sine wave
pulses of frequencies between 0 and 250Hz. It shows how the
response decays over time at each of those frequencies.

The ideal waterfall plot would have a smooth profile and decay
evenly to a low level within 0.5 to 0.8 seconds. Peaks or dips
in the waterfall plot indicate resonances or absorption at the
corresponding frequency. Ridges extending forwards in time
indicate reverberation at the corresponding frequency.

The room correction profile aims to identify the strongest
resonances and to reduce the decay time of each strong resonance
to the average decay time for the room.

Impulse response

You can select one of the following three graph types by clicking Ampituste R—
. . .o020
the corresponding tab. All three views of the measurement are 0 0025
- ooo3a
calculated from the same measured test signal: e
aaoin
Waterfall plot Ao
aonoa
Waterfall plat
-0 0005
-0.0010
Level (al), - SR
-0.0020/
-80.0
=0.0025
A =0.0027
=200 aa 1.0 20 30 40 so
Time (sec)

-100.0

-1100 ] a=a - Shows the response over time of the loudspeaker to a click. The

1700 = o curve shows a maximum just after time zero, and then decays

i ; ' P 2T sec) rapidly depending on the amount of reverberation in the room. Any
additional peaks in the response indicate resonances set up by the
initial impulse.
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Low frequency response

Level {aB)
80D
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Shows the loudspeaker-room response to a low frequency sine
wave, swept between 0 and 250Hz. The ideal low frequency
response would be smooth. A peak in the response indicates a
resonance at the corresponding frequency. A dip in the response
indicates absorption or cancellation at the corresponding frequency.

To display the value of the curve at any point
 Drag to position the vertical red cursor.

The values of the curve at the current point are displayed in the top
right-hand corner of the plot:
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In the Waterfall Plot the values displayed correspond to Time = 0.

To change the axes
o Click the Axes... button to display the axis parameters.

The Data Range section on each tab shows the range of the data
measured by the Room Correction procedure.

The View Range section on each tab allows you to set the range
of the Frequency, Level, Time, and Amplitude axes as appropriate
for each plot:

Data Flang:
Frequency: 0.0000

Wiew Rangs

Frequency: [00000 =] to [250.0000 =] Ha

o 250.0000 Hz

Level: -220.0000 to -78.0000 dB Level: —1?5.00003: tg |78.0000 = dB
Time: 0.0000 to 1.5000 sec Time: 0.0000 3: o |1.5000 3: sec

To repeat measurements

You can repeat measurements for one or more channels;
for example, if an external sound interfered with an existing
measurement.

e Right-click the measurement you want to repeat, then click Re-
measure... on the context menu:

] Hew
Rename
¥ Delete

A Mesous

) Wiew Plat




The following dialogue box allows you to select which channels
you want to repeat:

Speakers to Measure |
@ Please select the speakers ta be [ejneasured.
Cancel g
Channel | Layouts [ Status I

[IFrontleft  MusiciLogic/51 Movie  Measwed

[|Frontright  Music/Logio/5.1 Movie  Not messured
Front centre Music/Lagic/5.1 Movie Mot measured
[¥] Centre Sub Music Not messured
[“IFearleft  MusiciLogic/51 Movie Mot measured
Rearright  Music/Logic/5.1 Movie Mot measured
LFESub 5.1 Movie Kot measured

Measurement of the selected speakers will take approximately & minutes.

e Select the channels you want to repeat.

o Click the OK button to confirm your selection.

The following dialogue box warns you that the existing
measurements will be overwritten:

Overwrite Measurements x|

“ou have chosen ko 1emeasure one of mors channels.
This will cveraite: any previous measurements. Continue?

o Click the Yes button to continue, or the No button to retain the
existing measurements.

The following dialogue box then indicates how long the selected
measurements will take, and gives you an opportunity to leave the
room before the test sequence begins:

Begin Measurements 2|

@ The measurements will take approximately & minutes to complete.

During sach measurament there will bs & period of loud noiss
You may wish ta leave the room ot this point

{Heain (i3] Cancel

To create multiple measurements

You can create additional measurement sets to take account of
different configurations of the room, such as with curtains open or
closed.

o Right-click the Measurements tab, then click New on the
context menu.

A new measurement set will be added to the list, and the
Speakers to Measure dialogue box will be displayed to allow
you to specify which speakers you want to measure.

o Click the OK button to proceed with the measurement.

To rename a measurement set
o Right-click the measurement set, then click Rename on the

context menu, or press .

o Edit the name as required and press (.

To delete a measurement set
e Right-click the measurement set, then click Delete on the
context menu, or select the measurement set and press ([Del.
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Viewing profiles

The Profiles tab shows a list of the profiles that have been
calculated, together with the number of filters used for each profile
and the number of remaining filters available:

Measurements  Frofiles |

Profile name Layout Filters Awailable ‘
< 43 11

5 1 Movis
gic Logic 43 1
< Music Music 51 3

Each profile can use up to 60 filters; if a profile requires more
filters than this, filters will be allocated in order of priority.

Each channel is limited to a maximum of 20 filters; a two-channel
system therefore has a limit of 40 filters.

To build the filters for a profile
e Right-click the profile in the Profiles list, then click Build... on
the context menu:

The following dialogue box then allows you to specify a target
decay time:

Target Decay 21x|
If you choose a manual target decay
time, you must specify a value between k
100 ‘and 1000 millsecands {inclusive], Cancel
= {utamatic
o T=1|
Manual |40 oy meec

e Leave Automatic selected, or click Manual and enter a delay
time between 100 and 1000 milliseconds.

e Click the OK button to continue.

If you have more than one measurement set the following dialogue
box is displayed to allow you to select which measurement set you
want to use for the filters:

Build Filters - Select Measurement Set 2=l
Measurement 5et 0K
|M
Sofa L Cancel

Note: The process of building filters is computationally intensive,
and it is recommended that you do not try to run other programs
at the same time.

As the filters are calculated the status is shown in the lower half of
the Room correction page.

To store profiles temporarily to the digital surround
controller

You can store profiles temporarily to the digital surround controller
so you can listen to them while using Meridian Room Correction.

e Right-click the profile in the Profiles list, then click Store on the
context menu.

The lower half of the Room correction page shows the progress
as the profile is stored to the digital surround controller.




Editing filters

After building the filters for a profile you can edit the filters
numerically or graphically to adjust their parameters, or change the
response of each filter.

Note: This should only be attempted by users with an
understanding of filter design. It is strongly recommended that you
copy the profile first and then edit the copied profile. There is no
undo function within Edit filters.

To display the filters for a profile
e Right-click the profile in the Profiles list, then click Edit... on
the context menu, or double-click the profile in the Profiles list.

The Edit Filters window shows a numeric or graphical display of
the filters in the profile.

e Choose a channel from the Channel drop-down list to display
the filters for that channel, or choose All Channels to show all
the filters for all channels on a single display.

To view the filters numerically
e Select Numeric.

The columns give the Centre Frequency (Hz), Gain (dB), Filter
Bandwidth (Hz), Room Mode Bandwidth (Hz), Equalized Bandwidth
(Hz), RTg (s), Target RTgq (), and Channel:

i Edit Filters - Movie - 5.1 Movie (=] ]

i Centr.. [ Gain(.[ Fiter... [ Room. [ Equal. [ AT60.. [ Targe..[ Cha
Charrel [Fontiet =] | | ER] 36 23 57 L
& Numeric {75 58 45 33 63 0676 0348 L
 Graphical fra3 43 53 4.2 69 058 03 L

B {25 38 57 47 71 0473 0311 L
Froquency [610 =z i $e1zm 2z k2 55 71 0403 03 L
Gain 61 =@ ¥
it 36 = He

43/60 filters used,

5/20 filters used on this channel.

The fields on the left of the filters list allow you to adjust the
Frequency, Gain, and Width of the currently selected filter.
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To view the filters graphically The currently selected filter is displayed with a red vertical bar
o Select Graphical: at the filter centre frequency, and a rectangle indicating the
bandwidth and gain of the filter.
! Edit Filters - Movie - 5.1 Movie o) x|
Migw o
Cranmet [Fontt 7] | | o= Fliter response - Front left You can edit each parameter of the filter interactively as described
 Numeric . . .
@ Graphical 2 in the following sections.
a
Eequency: [610 = Hz 13 | -2
e [ He || Centre frequency
idth: 2E = Hz . . 3
ij;'” , = - o Drag the vertical bar to the left or right on the filter response
ilters used. -10
5720 fiers e on s chanrel, | <12 curve, or press [« or (=]
14
16
12
-20
0O 20 40 B0 30 10012014C160180200220240
Freguency (Hz)
A
To edit a filter o
o Select the filter you want to edit by clicking on the filter:

Gain
e Drag the base of the filter, or press (1] or (1]

Alternatively if the filters are close together you can step right or

left between filters using or (Ctrl) (Shift] Tab).




Bandwidth
e Drag one of the sides of the filter, or press or [Ctrl[=):

o

/

o e

To add a filter
o Click the Add button on the Numeric or Graphical tab:

o Edit the parameters of the filter as described above.

To delete a filter
o Select the filter you want to delete in the Filters list, or on the
Graphical tab.

o Press [Del], or click the Delete button:

X
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Changing settings at a later date

This section describes how to change the room correction or
configuration settings of the digital surround controller at a later
date, subsequent to storing the original version.

Note: You can only edit or add to existing profiles if you have the
MSL file originally used to design the profile. If you do not have the
original MSL file you will need to make new measurements, create
new profiles, and then store these to the digital surround controller.

To edit an existing profile, or add a new profile
® Run the Meridian Configuration Program and open the MSL file
used to create the original profiles.

If you have changed settings on the digital surround controller
since the original profiles were made, and you want to retain these
changes:

© On the File menu, click Save as to save the MSL file under a
new name.

To fetch the settings from the digital surround controller:

© On the Products page, right-click the controller, then click
Fetch... on the context menu.

o Step forward to the Room correction page in the Breadcrumb
Trail.

o Select the Profiles tab, and proceed as described in Editing
filters, page 41.

To change other settings if you have the original MSL file
e Run the Meridian Configuration Program and open the original
MSL file.

If you want to keep the original settings:

 On the File menuy, click Save as to save a copy of the MSL file
under a new name.

e Change the settings as required and store the new settings to
the digital surround controller.

For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide
for your product.

To change other settings if you have lost the original MSL
file

If the original MSL file is not available you will be able to change
all non-room correction settings, and which room correction profile
you want to use with a given preset.

o Start a new document.

 On the File menuy, click Fetch to fetch the settings from the
digital surround controller.

The newly created file will contain the profile labels and these can
be used to choose the profile you want to use with a given preset.
It will not contain measurements or profile data for Meridian Room
Correction. If you use Meridian Room Correction to create new




measurements and profiles and store these to the digital surround
controller, the old profiles will be overwritten.

e Change the settings as required and store the new settings to
the digital surround controller.

For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide
for your product.

To change other settings directly on the digital surround
controller

For information about changing other configuration settings on the
digital surround controller refer to the Installation Guide for your
product.

After making changes on the digital surround controller you can
add these changes to an existing MSL file as follows:

 Run the Meridian Configuration Program and open the original
MSL file.

 On the Products page, right-click the controller, then click
Fetch... on the context menu to fetch the new settings from the
digital surround controller.

If you want to keep the original settings:

* On the File menu, click Save as to save a copy of the MSL file.
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Troubleshooting

This section gives suggested solutions to typical problems that
may occur when using Meridian Room Correction. If problems
still persist after working through the following steps please send
an email to support@meridian.co.uk with a zip file containing
your MSL file. Please also supply details of the loudspeakers and
amplifiers you are using.

Failed microphone/SPL meter test

During the first measurement a microphone test is performed
to ensure that the power and SNR (signal to noise ratio) are
acceptable. The larger the SNR the better the measurement.

The following sections describe some of the most likely problems
which will cause the power and SNR values to go outside these
ranges.

Power result “Bad”
This indicates that there is very little or no signal on the connector
you have chosen as your microphone input.

e Check that there was sound from the front left speaker during
the test.

If in doubt, repeat the measurement. If there is still no sound check
the connections from the digital surround controller to the left
loudspeaker. Switch the digital surround controller off and then

on again, select Calibrate as described in the installation guide
for your digital surround controller, and check that the left speaker
plays the calibration signal.

o Ensure that the lead from the SPL meter is intact.

o Check that the SPL meter is switched on and set to the 90dB
band, or the band which includes 90dB, and with C weighting.

If the loudspeakers measured less than 75dB SPL during the
calibration phase it may be better to use the 80dB range.

e Check that the lead from the SPL meter is connected to the
correct input,
A8 (L) on the G68.

e Ensure that the Sensitivity setting is adequate for the SPL meter
or microphone.

The sensitivity value for analogue inputs is given in rms volts
(Vrms). For example, a sensitivity of 1Vrms allows a signal of
2.8Vpp. A sensitivity of 1V is recommended for use with most SPL
meters though 0.7V may be preferable for those with lower level
output.

Power OK, SNR result “Bad”
The most likely cause of this problem is that an analogue source is
connected to the input chosen for the microphone.

e Check that the lead from the SPL meter is connected to the input
you have chosen for the microphone test.

Another possibility is that the lead from the SPL meter is in bad
condition and only making a poor connection.

Power OK, SNR result “Poor”
The reasons for this are described in detail in the following section
where example measurements are also shown.




Repeated measurements due to poor SNR

Measurements are retried until the SNR is acceptable or the
maximum number of retries has been completed. The maximum
number of times each measurement will be retried due to poor
SNR can be set in the Preferences dialogue box, accessed from
the Options menu:

CITN——— 2=

Gieneral | Serial Port | Colows  Roem Correction |

Microphans
’V;aud I\AEIEI ] Input |A1 | Sensitvity: |1 w x|
Masimum measurement retries: |3 _,:

i OFK 1 Cancel
o |

The default number of retries is 3. If the measurements are
consistently giving poor SNR figures you can reduce the number of
retries. However, it is better to follow the steps described below to
improve the measurement conditions. The better the measurement
the more accurate the results when calculating the filters for a
profile.

-0.00D05.

-0.00010.

-0.0001

-0.00020.
-0.0002!

SPL meter is set on a low band

The following graph shows an impulse response obtained when a
Radio Shack SPL meter was set on the 60dB band. The SNR value
was “Poor":

Arnplituce Impulse respanse
0.034

0.030

0.025

0.020

0.015

0.010

0.005

0.000
-0.005

-0.010

-0.015

-0.020

-0.025

-0.030

-0.035

-0.039

0.0 1.0 2.0 3.0 4.0 5.0
Time (sec)

SPL meter is set on a high band

The following graph shows an impulse response obtained when a
Radio Shack SPL meter was set on the 120dB band. The tail of the
response is generally noisy. The SNR value was acceptable but the
power was “Bad":

Arnplitude Impulse respanse
0.0001

o.ooo1afl

0.00005|

0.00000)|

0.0 1.0 2.0 3.0 4.0 5.0
Time (sec)
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Loudspeaker is running in a non-linear range

The effects of a loudspeaker running in a non-linear range is most
easily observed in the impulse response. The tail of the response
has small spikes, as shown in the plot below, where it should be
zero. The larger these spikes are relative to the largest value at the
beginning of the impulse response the smaller the SNR value:

Amplitude Impulse respense

0.0020

0.0015

0.0010

0.0005

0.0000

/N

-0.0005

-0.0010

-0.0015

-0.0020

-0.0025

-0.0030

-0.0032

Q.0 1.0 20 30 4.0 50

Time (sec)

o Check that the bass protection size has been correctly set — see
the Installation Guide for your product.

o Check that the bass drive unit in your loudspeaker is not rubbing.

e Check that your amplifier is not clipping.

If problems are still encountered, use the Speaker calibration
page to reduce the gain of the channel. Use the reduced gain
setting for the room correction measurements, then return to the
correct level for a calibrated system after running room correction
measurements.

Hum in the system

The effect of hum on the measurement is most easily observed in
the waterfall plot. The continuing signal at 50Hz and 150Hz in the
waterfall plot shown below indicates a mains hum loop:

Watmrtall plat

You are likely to have heard this level of hum when playing
analogue sources connected to the same analogue input card as
the microphone/SPL meter.

In order to get a better measurement disconnect analogue sources
from the analogue input card used for the room correction
measurements. Reorganise your speaker wiring to remove the hum
loop.

Hum may also be picked up by the lead from the microphone/SPL
meter. It is best to use a shielded cable to reduce the chances of
picking up hum.




Control Window

The Meridian Control Window emulates an MSR+ to allow you to control a Meridian product
from a PC via a serial or USB cable.

Control
Window

Running the Meridian Control
Window

e Click Start, point to Programs, Meridian, then click Control
Window:

|\ Internet __J My Documents
Internet Explorer

2) My Recent Documents +

I :
) My Pictures

E Hicrasoft word ) My Music
‘M o Jg My Computer

[ Accessories ¥ lork Places
@ Windows Media (= administrative Tools  »

_ & Meridian [ 2 Configuration Progiam Help
J Coldbor |5 Startup

Microsaft Access
Microsaft Excel
Microsaft FrontPage
Microsaft Outlook
Microsoft PowerPaint
Microsaft Word

4 MsN Explorer

% MM Messenger 6.0

Log OFF E)] Turn OFf Computsr

» B Configuration Progiam

The Meridian Control Window will be displayed:

== Control Window
This window sends commands to the product attached ta the serisl  pissannect | [f
port of your computer. The anow, Enter and Backspace keys act il

s shortouts for menu operations. Port: | com >

MR+ | MSR | Command

CD  Tifield ES

ﬁ@ﬂﬂﬂﬂﬂﬂﬂﬂ@%ﬂ
N Sl ]
Tl o] el o] ] e e
T el o fud Telwmlow] <]
i eltel (el eT o) e ] s
=]

ks

This provides the following tabs:

Tab Description

MSR+ Emulates an MSR+ Controller.

MSR Emulates an MSR Controller.

Command Allows you to send predefined commands, and

optionally specify arguments for the commands,
and then see the response from the product in a
terminal-style window.




Control
Window

Emulating an MSR+ or MSR

To send a command to the product
e Click the corresponding button on the Control Window.

The bar above the buttons shows the response from the product,
corresponding to the front panel display.

To enter a function key
Either:

e Click the Fn button followed by the button you want to enter.

or:

e Right-click the button or click the button while holding down
Ctrlf.

The legends of the buttons change to show the function options.

To lock the Fn button down

o (lick the Lock button:
4

Subsequent button presses will then enter function keys.

Press the Lock button or Fn button again to release the Lock
button.

To see the command corresponding to each button
Each button transmits a two-letter code to the product.

e Point to the button with the mouse pointer.

A tooltip shows the description of the key followed by the key's
command:

Select CD source [CD)]

You can also give commands by typing the key's command on the
computer keyboard. Note: Commands are case sensitive.

For example, to select the CD source type CD.

In addition, the following keys on the keyboard provide shortcuts
for the menu buttons:

Computer key MSR button
AV <>
Enter
(backspace) Return

To disconnect the Control Window
o (Click the Disconnect button.

To connect the Control Window
o Select the COM port you want to use from the Port drop-down
list.

o (Click the Connect button.

A warning triangle next to a port number indicates that it is in use
by another application.

To close the Control Window
e Click the Close button or press [Esg.




Using the Command tab

The Command tab lists all the available commands under four
headings: Source, General, Function + MSR keys, and Preset:

== Control Window 2x
This window sends commands to the product attached to the sefial  picconnect Close
port of your computer. You can also lype commands on the MSR — —
and MSR+ tabs. ot [Com =

MSR+ | MR Command

1D
+PN3
CD  Ambisonics BS

Function + MSR keys
= Presst

i (G0 to preset

* Direct Serd >
- Music
o Trifield

- Guper
i Steren

- MusicLogic
[ =

j’

To display the commands
e Click the + button to the left of one of the headings to show the
commands under that heading.

 Double-click the command you want to send.

To send a command with arguments
e Click the command in the Command list.

You will be prompted for the argument in the box below the
Command list.

o Enter the argument from the keyboard:

== Control Window - Meridian 861 - COM1 2|
This window sends commands to the product attached to the serial MI &I
port of yaur computer. Y'ou can also type commands on the MSH = =
and M5R+ tabs. Foit l—_[EDNH

MSR+ | MSR  Command |

eset to lupe n ‘I =0

olume minus
o ta valume (1-99]
0 to walume number

- Gubtitls select
Function + MSR keps
= Preset =
L] | 3
il A

o Click the Send button, or press (<], to enter the command.

Control
Window
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